USING MICROSOFT® OFFICE®

A GUIDE FOR USER’S TRANSITIONING FROM NOVELL® GROUPWISE®

JUNE 2013
© 2013 UNIVERSITY OF SOUTHERN CALIFORNIA. All rights reserved.

This manual, as well as the data and software implementation described in it, is furnished under license and may be used or copied only in accordance with the terms of such license. The content of this manual is furnished for informational use only, is subject to change without notice, and should not be construed as a commitment on the part of the University of Southern California.

Except as permitted by such license, no part of this publication may be reproduced, stored in a retrieval system, or transmitted, in any form or by any means, electronic, mechanical, recording, or otherwise, without the prior written permission of the University of Southern California.

The data and software implementation, as with all technical and computer-aided design software, is a tool intended to be used by trained professionals only. The data and the software implementation is not a substitute for the professional judgment of trained professionals. The software implementation is intended to assist with product design and is not a substitute for independent testing of product stress, safety and utility. The University of Southern California assumes no liability for any error or inaccuracies that may appear in this manual. The University of Southern California makes no warranties with respect to this manual and disclaims any implied warranties of merchantability and fitness for a particular purpose.

Microsoft and Microsoft Outlook are registered trademarks of the Microsoft Corporation.

Novell and Novell GroupWise are registered trademarks of the Novell Corporation.

U.S. Government Customers:

The Products are provided to the Federal government and its agency with RESTRICTED RIGHTS. USE, DUPLICATION OR DISCLOSURE BY THE GOVERNMENT IS SUBJECT TO RESTRICTIONS SET FORTH IN SUB-PARAGRAPH (c)(1)(ii) OF THE RIGHTS IN TECHNICAL DATA AND COMPUTER SOFTWARE CLAUSE AT DFARS 252.227-7013 OR SUB-PARAGRAPHS (c)(1) OR (2) OF THE COMMERCIAL COMPUTER SOFTWARE-RESTRICTED RIGHTS AT 48 CFR 52.227-19, AS APPLICABLE.
# TABLE OF CONTENTS

Preface .......................................................................................................................................................................................... 5  
Legal Notices .................................................................................................................................................................................... 5  
System Requirements ........................................................................................................................................................................ 6  
  Microsoft Windows Operating System ................................................................................................................................. 6  
  The University of Southern California (USC) System Requirements .................................................................................. 7  
Conventions Used In This Manual ................................................................................................................................................ 8  
Chapter 1: Getting Started .............................................................................................................................................................. 9  
  Frequently Asked Questions ....................................................................................................................................................... 9  
  Getting Started With Microsoft® Outlook® ............................................................................................................................. 10  
  Terminology ................................................................................................................................................................................ 10  
  Lynda.com Tutorials ............................................................................................................................................................... 10  
  E-Mail and Mailbox Size Limitations .................................................................................................................................. 10  
  Terminology Differences Between GroupWise® and Outlook® ............................................................................................ 11  
  Installing Microsoft® Outlook® 2010 ....................................................................................................................................... 12  
  Installing Novell ZENworks .................................................................................................................................................... 12  
  Installing and Configuring Microsoft Outlook 2010 .................................................................................................................. 20  
Chapter 2: Using Microsoft Outlook .................................................................................................................................................. 29  
  Accessing Your E-mail ............................................................................................................................................................ 29  
  Accessing Microsoft Outlook on Your Desktop or Laptop Computer ................................................................................... 29  
  Accessing Your E-Mail Using Outlook Web Application (OWA) .......................................................................................... 30  
  Accessing Your E-mail on a Mobile Device ............................................................................................................................... 32  
  Re-sending an E-mail Message .................................................................................................................................................. 70  
  Displaying Discussion Threads as Conversations .................................................................................................................... 71  
  Configuring Your Junk E-mail (SPAM) Settings ....................................................................................................................... 73  
  Creating Recurring Appointments ........................................................................................................................................ 77  
  Creating Rules and Signatures ................................................................................................................................................. 79  
  Creating a Rule ............................................................................................................................................................................. 79  
  Creating an E-mail Signature ................................................................................................................................................... 82  
  Creating and Accessing Your Personal Archive .................................................................................................................... 85  
  Creating an Archive ............................................................................................................................................................... 85  
  Accessing Your Personal Archive ........................................................................................................................................... 88  
  Posting a Message in a Folder .................................................................................................................................................... 89  
  Changing the Subject Line of Received E-mail Messages ................................................................................................... 93  
  Changing an Item Type ............................................................................................................................................................. 95  
  Giving and Receiving Delegate Access ................................................................................................................................. 97  
  Granting Delegate Access ....................................................................................................................................................... 97  
  Receiving Delegate Access ...................................................................................................................................................... 101  
  Accessing an Organizational or Resource Account in Outlook .................................................................................................. 102  
  Sending an E-mail to Shared Contacts .................................................................................................................................. 108  
  Searching Microsoft® Outlook® .............................................................................................................................................. 110  
Contact Dornsife Technology Services ........................................................................................................................................ 111
Legal Notices

© 2013 UNIVERSITY OF SOUTHERN CALIFORNIA. All rights reserved.

This manual, as well as the data and software implementation described in it, is furnished under license and may be used or copied only in accordance with the terms of such license. The content of this manual is furnished for informational use only, is subject to change without notice, and should not be construed as a commitment on the part of the University of Southern California.

Except as permitted by such license, no part of this publication may be reproduced, stored in a retrieval system, or transmitted, in any form or by any means, electronic, mechanical, recording, or otherwise, without the prior written permission of the University of Southern California.

The data and software implementation, as with all technical and computer-aided design software, is a tool intended to be used by trained professionals only. The data and the software implementation is not a substitute for the professional judgment of trained professionals. The software implementation is intended to assist with product design and is not a substitute for independent testing of product stress, safety and utility. The University of Southern California assumes no liability for any error or inaccuracies that may appear in this manual. The University of Southern California makes no warranties with respect to this manual and disclaims any implied warranties of merchantability and fitness for a particular purpose.

Android™ is a trademark of the Google Inc.
Apple®, Mac®, iPad®, iPod®, and iPod Touch® are registered trademarks of the Apple Corporation.
BlackBerry® is a registered trademark of the BlackBerry Corporation.
IronPort® is a registered trademark of the Cisco® Corporation.
Microsoft®, Microsoft Outlook®, and Windows® are registered trademarks of the Microsoft Corporation.
Novell® and Novell GroupWise® are registered trademarks of the Novell Corporation.

U.S. Government Customers: The Products are provided to the Federal government and its agency with RESTRICTED RIGHTS. USE, DUPLICATION OR DISCLOSURE BY THE GOVERNMENT IS SUBJECT TO RESTRICTIONS SET FORTH IN SUB-PARAGRAPH (c)(1)(ii) OF THE RIGHTS IN TECHNICAL DATA AND COMPUTER SOFTWARE CLAUSE AT DFARS 252.227-7013 OR SUB-PARAGRAPHS (c)(1) O R (2) OF THE COMMERCIAL COMPUTER SOFTWARE-RESTRICTED RIGHTS AT 48 CFR 52.227-19, AS APPLICABLE.
System Requirements

This document details the system requirements to run Microsoft® Outlook®. Review the document's contents by:

- **Microsoft Windows® Operating System**
- **The University of Southern California System Requirements**

**Microsoft Windows Operating System**

Your computer system must meet the following requirements to successfully run Microsoft Outlook 2010 for Windows operating system.

<table>
<thead>
<tr>
<th>Component</th>
<th>Requirement</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Computer and Processor</strong></td>
<td>500-megahertz (MHz) processor or higher</td>
</tr>
<tr>
<td><strong>Memory</strong></td>
<td>512 megabytes (MB) OF RAM recommended for accessing Microsoft Outlook data files larger than 1GB*</td>
</tr>
<tr>
<td><strong>Hard Disk</strong></td>
<td>2 gigabytes (GB) available disk space</td>
</tr>
<tr>
<td><strong>Display</strong></td>
<td>1024 × 576 or higher resolution monitor</td>
</tr>
<tr>
<td><strong>Operating System</strong></td>
<td>Supports only the 32-bit edition of Office 2010:</td>
</tr>
<tr>
<td></td>
<td>• Windows XP with Service Pack 3 (SP3)</td>
</tr>
<tr>
<td></td>
<td>• Windows Server 2003 Service Pack 2 (SP2), MSXML 6.0</td>
</tr>
<tr>
<td></td>
<td>• Windows Server 2003 R2</td>
</tr>
<tr>
<td></td>
<td>Supports both 32-bit or 64-bit editions of Office 2010:</td>
</tr>
<tr>
<td></td>
<td>• Windows Vista with Service Pack 1 (SP1)</td>
</tr>
<tr>
<td></td>
<td>• Windows 7</td>
</tr>
<tr>
<td></td>
<td>• Windows 8</td>
</tr>
<tr>
<td></td>
<td>• Windows Server 2008</td>
</tr>
<tr>
<td></td>
<td>• Windows Server 2008 Service Pack 2 (SP2)</td>
</tr>
<tr>
<td></td>
<td>• Windows Server 2008 R2</td>
</tr>
<tr>
<td></td>
<td>• Windows Server 2008 R2 Service Pack 1 (SP1)</td>
</tr>
<tr>
<td></td>
<td>• Windows Server 2012</td>
</tr>
<tr>
<td></td>
<td>• Terminal Server</td>
</tr>
<tr>
<td></td>
<td>• Windows on Windows (WOW), which allows installation of 32-bit versions of Office 2010 on 64-bit operating systems, excluding Windows Server 2003, 64-bit and Windows XP, 64-bit.</td>
</tr>
<tr>
<td></td>
<td>Doesn’t support any edition of Office 2010:</td>
</tr>
<tr>
<td></td>
<td>• Windows Server 2003, 64-bit</td>
</tr>
<tr>
<td></td>
<td>• Windows XP, 64-bit</td>
</tr>
<tr>
<td><strong>Other</strong></td>
<td>Internet Explorer 6, Internet Explorer 7, or Internet Explorer 8, 32-bit browser only. Additional services may require an Internet connection.</td>
</tr>
</tbody>
</table>

**NOTE:** Grammar correction and contextual spelling in Microsoft Outlook is not turned on unless the computer has 1 GB memory.
The University of Southern California (USC) System Requirements

In order to ensure the integrity of university data, USC requires all laptops and mobile storage devices that are paid for with university funds and/or used for USC business purposes to be encrypted. As an additional security measure, we strongly encourage you to avoid storing any sensitive data on such equipment altogether.

Laptops and mobile storage devices purchased on or after April 22, 2009 must be either a.) delivered with built-in encryption (preferred) or b.) accompanied by a software-based encryption solution for subsequent installation. All encryption solutions purchased separately must be installed before the instrument may be used to store or access university data. This policy applies to laptops and mobile storage devices purchased from all sources of university funds, including sponsored project accounts, and applies to laptops and mobile storage devices used for business purposes but purchased with personal money.

For assistance with encryption compliance, contact the College and Libraries Help Desk at clhd@usc.edu or (213) 740-2775.
Conventions Used In This Manual

Certain standards and conventions have been employed in this user guide to communicate in the most effective manner possible. These standards have been used whenever possible.

Bold Text

Normally, bold text is used:

- to emphasize an important concept
- to denote a clickable item on the user interface (for example, the directions may state: “Click the **Button Name** button...”)
- to specify a menu item (for example, “...from the **File > Print** menu item...”)

Italicized Text

Generally, italics are used to denote:

- field names on the user interface (e.g., “Type your USC ID in the **Field_Name** field”)
- an “either-or” situation (denoted: *or*)
- window, dialog box, or page name (e.g., the **System Requirements** page)

Examples, Scenarios, Screen Captures

All examples shown or described in this guide are for training and illustration purposes only.

Implementation Requirements

The data and software implementation described in this manual are furnished under license and may be used only in accordance with the terms of such license. See your license for all terms and conditions that apply.
Frequently Asked Questions

Below are some of the most frequently asked questions (FAQ) about the conversion from Novell® GroupWise® to Microsoft® Outlook®. Use the FAQ information to assist you with basic questions you might have about Outlook.

Why are we changing from GroupWise to Outlook?

There are many reasons why Outlook was selected to be the primary e-mail client for The University of Southern California (USC) Dornsife College of Letters, Arts and Sciences. They include:

- Increased stability and performance
- Utilization of "cloud-based" technology while maintaining a high level of security
- A more user-friendly e-mail client
- Robust Mac support via the new Outlook 2011 client for OS X and the native OS X Mail, Calendar and Address Book applications
- Outlook Web Access (OWA) client, available for use with all major browsers
- Access your account using your USC username and password, the same credentials you are already using for many Dornsife and campus-wide resources including MyDornsife, MyUSC, Blackboard, Lynda.com, VPN and Kuali
- Improved mobile support for iOS, Android, Blackberry and Windows Phone devices
- 25 GB for your mailbox, 100 GB for your personal archive and up to 25 MB attachments
- Future cross-campus calendar availability search functionality

Will I have e-mail access during the time that my account is being converted?

No, you will not have e-mail access during that time. On the day you are converted from using Novell GroupWise to Microsoft Outlook, you may experience interrupted access to your e-mail account. The access interruption will, typically, occur between 5:00AM and 9:00AM. No e-mail data will be lost due to this access interruption.

Will all of my e-mails, archives, and other items be moved to Outlook for me?

Yes, all of your e-mails, archive files, cabinets, and address books will be moved from GroupWise to Outlook. Your personalized e-mail signature, out of office notifications, and other e-mail "rules" that you have configured will not be moved to Outlook from GroupWise. You will need to reconfigure these items, as well as re-assigning access to shared folders, after the conversion is complete.

What if I encounter a problem after the migration?

Contact the College and Libraries Help Desk at clhd@usc.edu or (213) 740-2775 for assistance if you experience any difficulties with logging into Outlook or if all or some of your files were not transferred to Outlook from GroupWise.
Getting Started With Microsoft® Outlook®

Terminology
Getting started with Microsoft Outlook is quite simple! Microsoft Outlook and Novell® GroupWise® operate, appear, and perform the same functions in very similar ways. The primary difference that you may notice is that the names for familiar tasks and actions are different in the two programs. For instance, in GroupWise the location from which you can view all of your unread e-mail messages is named the Mailbox. In Outlook, this same location is named the Inbox. Both the Mailbox and the Inbox perform the same function, but they have different names. There are a variety of functions within Outlook that have a different name from the corresponding function in GroupWise. See the Terminology Differences chart for assistance with the naming conventions in Outlook that differ from GroupWise.

Lynda.com Tutorials
If you are using Microsoft Outlook for the first time and need in-depth instructions on how to use Outlook, navigate to Lynda.com. Lynda.com is a cloud-based online training service with over 2,000 training modules for software packages, programming languages and general technology topics. Below are recommended training modules for the Outlook client. After you select the link, you will be prompted to enter your University of Southern California (USC) username and password. By logging in with your USC username and password, there is no charge to review the training modules.

- [Outlook 2010 for Windows Essential Training](#)
- [Outlook 2010 for Windows Power Shortcuts](#)

E-Mail and Mailbox Size Limitations
The following is a listing of size limits for e-mail message attachments, personal archive, etc. This information is provided for your reference.

<table>
<thead>
<tr>
<th>Item</th>
<th>Size Limit</th>
</tr>
</thead>
<tbody>
<tr>
<td>Mailbox</td>
<td>25 GB</td>
</tr>
<tr>
<td>Personal Archive</td>
<td>100 GB</td>
</tr>
<tr>
<td>Attachment Size</td>
<td>25 MB</td>
</tr>
<tr>
<td>Maximum E-mail Recipients Per E-mail</td>
<td>500</td>
</tr>
</tbody>
</table>
Terminology Differences Between GroupWise® and Outlook®

When you begin using Microsoft® Outlook®, you will notice that features are named differently in Outlook than they are in GroupWise®. Below is a translation table that lists the GroupWise term and the corresponding Outlook term. When applicable, each term is a link to an associated help topic.

<table>
<thead>
<tr>
<th>GroupWise Term</th>
<th>Outlook Term</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Send and Receive</strong></td>
<td></td>
</tr>
<tr>
<td>Mailbox</td>
<td>Inbox</td>
</tr>
<tr>
<td>Trash</td>
<td>Deleted Items</td>
</tr>
<tr>
<td>Work in Progress</td>
<td>Inbox</td>
</tr>
<tr>
<td>Junk Mail</td>
<td>Junk E-mail</td>
</tr>
<tr>
<td>Email Delivered Status</td>
<td>Email Delivered Receipt</td>
</tr>
<tr>
<td>Return Notification When Opened</td>
<td>Email Read Receipt</td>
</tr>
<tr>
<td>Return Notification When Deleted</td>
<td>Email Deleted Without Being Read Notice</td>
</tr>
<tr>
<td>Urgent - High/Low</td>
<td>Importance - High/Low</td>
</tr>
<tr>
<td><strong>Organization</strong></td>
<td></td>
</tr>
<tr>
<td>Cabinet</td>
<td>Personal Folders</td>
</tr>
<tr>
<td>Shared Folder(s)</td>
<td>Folder(s) With Permissions</td>
</tr>
<tr>
<td><strong>Events</strong></td>
<td></td>
</tr>
<tr>
<td>Appointment</td>
<td>Meeting</td>
</tr>
<tr>
<td>Appointment Accepted</td>
<td>Meeting Accepted</td>
</tr>
<tr>
<td>Appointment Declined</td>
<td>Meeting Declined</td>
</tr>
<tr>
<td>Appointment Tentatively Accepted</td>
<td>Meeting Tentatively Accepted</td>
</tr>
<tr>
<td>Appointment Request Read</td>
<td>Meeting Request Read</td>
</tr>
<tr>
<td>Appointment Request Delivery</td>
<td>Meeting Request Delivery</td>
</tr>
<tr>
<td>Appointment Reminder Times</td>
<td>Meeting Reminder Times</td>
</tr>
<tr>
<td>Recurring Appointments</td>
<td>Recurring Meetings</td>
</tr>
<tr>
<td>Alarm</td>
<td>Reminder</td>
</tr>
<tr>
<td><strong>Tasks</strong></td>
<td></td>
</tr>
<tr>
<td>Work in Progress/Checklists</td>
<td>Tasks</td>
</tr>
<tr>
<td>To-do List</td>
<td>Task List</td>
</tr>
<tr>
<td><strong>Miscellaneous</strong></td>
<td></td>
</tr>
<tr>
<td>Personal Address Book</td>
<td>Outlook Address Book</td>
</tr>
<tr>
<td>Novell GroupWise Master Address Book (System)</td>
<td>Global Address List (Exchange system)</td>
</tr>
<tr>
<td>Busy Search</td>
<td>Free/Busy Search or Scheduling Assistant</td>
</tr>
</tbody>
</table>

©2013 University of Southern California. All rights reserved.
CHAPTER 1: GETTING STARTED

Installing Microsoft® Outlook® 2010

The purpose of this guide is to explain how to download, install, and configure Microsoft Outlook 2010. Follow the steps as detailed in this document. If you encounter any issues, contact the College and Libraries Help Desk at 213-740-2775 or clhd@usc.edu.

This guide details the installation process for Windows® 7. However, the process for Windows XP® or Vista® will be extremely similar.

NOTE: If you already have Novell® ZENworks® installed on your system, DO NOT RE-INSTALL ZENworks. Go directly to the Installing Microsoft Outlook 2010 section of this document.

Installing Novell ZENworks

1. Select the Start icon, located on the lower left side of the screen. The Start menu displays.

![Select Control Panel.](image)
2. Select **Control Panel** from the right side of the menu. The *Control Panel* displays.

3. Select the **System** option. The *System* window displays.
4. Locate the *Computer name, domain and workgroup settings* section and select **Change settings**. The *System Properties* window displays.
5. On the **Computer Name** tab of the *System Properties* window, select the **Change...** button. The *Computer Name/Domain Changes* window displays.

6. Enter the designated hostname for your computer in the **Computer name:** field. Desktop computers at USC have a designated hostname that should be used. If you do not know the designated hostname of your computer, you can locate the name by visiting [http://www.displaymyhostname.com/](http://www.displaymyhostname.com/).

   If your desktop/laptop computer already has a name listed in the **Computer name:** field that is not the designated hostname, remove the existing name from the **Computer name:** field and replace it with the designated hostname.

   If you are using a laptop computer or a desktop computer that does not have a static designated hostname, enter a unique, identifying name in the **Computer name:** field. The name you choose must be 15 characters or less. For example, you might name your laptop JohnDoeLaptop or JaneDoeEALCPC. If a name already exists in the **Computer name:** field, remove the existing name and replace it with a name of your choosing.

   You will provide the name of your computer to the College and Libraries Help Desk later in this process.
7. Select the **OK** button to save your changes. You may be prompted to restart your computer. Select the option to **Restart Later**.

![Microsoft Windows notification dialog](image)

8. Launch your web browser and navigate to [https://mydornsife.usc.edu/](https://mydornsife.usc.edu/). Log into the *MyDornsife Portal*, if necessary, and then select the **Download Software** hyperlink, located on the **Personal Tools** tab.

![Personal Tools tab with Download Software highlighted](image)

The **Download Software** page displays.
9. Locate ZENworks® Agent for Windows and select the corresponding Download hyperlink.

The File Download - Security Warning window displays.

10. Select the Run button to begin the download.
11. Some versions of Windows® display a User Account Control window before installing new software. If the User Account Control window displays, select the Yes button to authorize the installation. You may have to enter your login credentials, as well.

12. The ZENworks Agent application begins to install and the installation's progress is displayed in the Windows task bar.

13. When the installation is complete, the Reboot Required window displays. Select the Yes button and restart your computer at this time.
14. After restarting your computer, select the ZENworks icon from the task bar. The ZENworks icon should appear similar to the following image.

15. The ZENworks Configuration Management window may display. Select the Cancel button. It is not necessary to enter your login credentials, at this time.

16. Right-click on the ZENworks icon in the task bar. Select Show Properties.
17. The ZENworks Adaptive Agent window displays. Verify the Device Name. The Device Name should match the name you entered in the System Properties menu.

Installing and Configuring Microsoft Outlook 2010

1. E-mail the Device Name (see Step 6 in the previous section) of your computer to clhd@usc.edu and request that it be assigned an Microsoft Office 2010 license. You will receive an e-mail confirmation once the license has been assigned.

2. After the license has been assigned, right-click on the ZENworks icon in the task bar and select Refresh.
3. Microsoft Office 2010 will begin to download and install. When the installation is complete, the **Microsoft Outlook 2010** icon will appear on your desktop. Alternately, you may access Microsoft Outlook 2010 from the **Start** menu.

![Start Menu with Microsoft Outlook 2010 Icon]

Close any open Microsoft programs, at this time, to prevent installation conflicts.
4. The account configuration process begins. Select the **Next** button to continue.

The **Account Configuration** window displays.
5. Select the Yes radio button to indicate that you want to continue with the new account setup process. Then, select the Next button to continue.

The Add New Account window displays.
6. Complete the following fields to setup your USC e-mail account.
   A. **Your Name:** Enter your first and last names in this field.
   B. **E-mail Address:** Enter your USC e-mail address in this field. You must enter the entire e-mail address, e.g., firstnamelastname@usc.edu.
   C. **Password:** Enter your USC password.
   D. **Retype Password:** Retype your USC password.

Select the **Next** button to continue.
7. Outlook will attempt to verify the server settings for the account information you entered.
8. Green checkmarks appear next to each account verification process, if the process completed successfully. Select the **Finish** button when your e-mail account has been successfully verified.
9. You may be prompted for your username and password by Windows Security. Re-enter your USC e-mail address in the *Username* field and your USC password in the *Password* field and then select the **OK** button.

Account setup is now complete. Outlook will begin to synchronize your account. Depending on the size of your account, the synchronization process might take several hours to complete.
CHAPTER 2: USING MICROSOFT OUTLOOK

CHAPTER 2: USING MICROSOFT OUTLOOK

Accessing Your E-mail
After your e-mail account has been converted for use with Microsoft® Outlook®, you have the ability to access your account in a variety of ways. This topic contains information on accessing your e-mail through Microsoft Outlook from a desktop or laptop computer, Outlook Web Application (OWA), and on mobile devices.

Accessing Microsoft Outlook on Your Desktop or Laptop Computer
Accessing your University of Southern California (USC) e-mail account through the Microsoft Outlook desktop program is simple. For a majority of users, an icon for Microsoft Outlook will appear on your desktop. An example of how the icon will appear is displayed below.

Launch the application by clicking on the icon. Microsoft Outlook will go through an initial download and configuration process. When the process is complete, the application is ready to use.

You will be prompted to enter your USC e-mail address and password when the initial download and configuration process is complete.

NOTE: You must use your full USC e-mail address to login. Example: johndoe@usc.edu

After logging into Outlook with your USC e-mail address and USC password, you can begin working with your e-mails, calendar, and archive items. No further setup is required before using the program.

NOTE: If you do not see an icon for Microsoft Outlook on your desktop (Windows) or in your Applications folder (Mac), you will need to install the application.

Contact the College and Libraries Help Desk at clhd@usc.edu or (213) 740-2775 for assistance if you experience any difficulties with logging into Outlook or if all or some of your files were not transferred to Outlook from GroupWise.

©2013 University of Southern California. All rights reserved.
Accessing Your E-Mail Using Outlook Web Application (OWA)

If you are away from the computer on which you normally access Outlook, or you want to utilize the Internet-based option exclusively, the Outlook Web Application is a fast and easy way to access your e-mail via a web browser.

**NOTE:** To ensure that the browser through which you are accessing OWA is supported by the application, visit the [Outlook Web Application support page](http://dornsife.usc.edu/365) for a listing of compatible browsers.

To begin using OWA, navigate to http://dornsife.usc.edu/365 in a supported web browser. A username and password prompt box displays.

Enter your USC ID in the *User Name:* field and your USC password in the *Password:* field. An example is shown below, though the box may be different in appearance depending upon which web browser you utilize.
Select the **OK** button. The Outlook Web Application displays similarly to the following example.

You can access your e-mails, personal folders, and calendar from the Outlook Web Application. OWA and your desktop Outlook are identical, kept that way through cloud-based syncing.

If you experience any difficulties with OWA, contact the College and Libraries Help Desk at clhd@usc.edu or (213) 740-2775.
Accessing Your E-mail on a Mobile Device
You can access your USC e-mail on the following mobile devices:

- Android®
- BlackBerry®
- BlackBerry 10
- iPhone®/iPod Touch®/iPad®
- Windows
- Any mobile device that supports ActiveSync®.

Mobile devices that use POP or IMAP e-mail settings are not supported. If your mobile device does not support ActiveSync, you can still access your USC e-mail through a supported mobile browser.

Configuring Your E-mail For Use On An Android Device
Follow the steps below to configure the e-mail client on your Android mobile device for use with your USC e-mail account.

| NOTE: | The exact steps required to setup your Exchange account on an Android device can vary greatly between devices. The process described below provides an example and alternatives to help guide you. If you cannot configure your Android device based on the instructions provided, please contact Dornsife Technology Services. |

1. Tap the Menu button, located on the left side of the Home button.

The Menu displays.
2. Tap **Settings**.

The **Settings** screen displays.
3. Swipe down the screen to the *Accounts* section. Tap **Add Account**. On some devices this option may be labeled **Accounts & Sync**.

The *Add account* screen displays.
4. From the Add account screen, tap Email or Mail, depending upon your Android configuration.

The Set up email screen displays.
5. Tap **Corporate**. Depending upon your Android configuration, this option may appear as **Microsoft Exchange**, **Exchange Account**, or **Exchange ActiveSync**.

The **Add an Exchange account** screen displays.
6. On the Add an Exchange account screen, enter your USC e-mail address and password.

**NOTE:** You must use your full USC e-mail address to login.

**Example:** johndoe@usc.edu
7. Tap **Next**. The information you entered is verified. Once the verification process is completed, the *Exchange server settings* screen displays.
8. Tap **Next** on the *Exchange server settings* screen. The *Account options* screen displays.

The *Account options* screen controls the type of notifications (if any) you will receive when new e-mail is downloaded, how much of your e-mail to sync, the calendar period to sync, and the items you want to sync, such as e-mail and contacts. This screen will appear differently depending upon your Android configuration. The settings on this screen are entirely based upon your preference, except for the **Sync Email** option. **Sync Email** must be selected in order for your USC e-mail account to function on your Android device.

**NOTE:** The Sync Email option must be selected in order to access and sync your USC e-mail account.
After configuring the account options, swipe down the screen and tap Next.

The Set up email screen displays.
9. On the *Set up email* screen, enter an account name for this e-mail account. This step is optional.

![Set up email screenshot]

This completes the setup process for Android devices. Your USC e-mail account is now available for use on your device.

**NOTE:** The configuration process for Android devices may vary greatly from device-to-device. For additional assistance, visit the Microsoft Mobile Device Configuration Wizard topic or contact the College and Libraries Help Desk at clhd@usc.edu or (213) 740-2775.
Configuring Your E-mail For Use On A Classic BlackBerry® Device

Follow the steps below to configure the e-mail client on your BlackBerry OS 7.1 mobile device for use with your USC e-mail account. If an older version of the BlackBerry operating system is being used, the process is similar.

1. From the device’s desktop, select the Options (wrench) icon.

The Options screen displays.

2. Use the trackball or trackpad to scroll down the Options screen and select Device.

The Device screen displays.

The Advanced System Settings screen displays.


The Enterprise Activation screen displays.
5. On the *Enterprise Activation* screen, you must populate the *Email:* and *Activation Password:* fields. Enter your correctly formatted e-mail address (see **Note** below) and your activation password. If you do not have an activation password, contact the College and Libraries Help Desk at clhd@usc.edu or (213) 740-2775 to obtain an activation password. After entering the appropriate information, select the **Activate** button.

**NOTE:** Your e-mail address must contain the word "exchange" after the @ symbol in order for your e-mail account to correctly sync with your BlackBerry.

**Example:** jdoe@exchange.usc.edu

The use of the word "exchange" does not change your e-mail address. Your e-mail address will continue to be yourUSCID@dornsife.usc.edu.
6. After selecting the **Activate** button, you may receive a message prompting you to erase all the data from your BlackBerry device. Erasing your device data is not required or recommended in this scenario. Select the **No** button on the message prompt.

![Select the No button.]

The **Activation - Complete** screen displays.

7. The activation process is complete. Click the **OK** button on the **Activation Complete** message prompt.

![Select the OK button.]

This completes the setup process for BlackBerry OS 7.1 devices. Your USC e-mail account is now available for use on your device.
Configuring Your E-mail For Use on a BlackBerry 10 Device

Follow the steps below to configure the e-mail client on your BlackBerry OS 10 mobile device for use with your USC e-mail account.

1. From the device's desktop, locate and tap the **Settings** icon.
2. The *System Settings* screen displays. Tap the **Accounts** option.
CHAPTER 2: USING MICROSOFT OUTLOOK

3. The Add Account screen displays. Tap **Email, Calendar and Contacts**.
4. The Add Account screen displays. Enter your USC e-mail address and then tap Advanced.
5. The *Advanced Setup* screen displays. Tap the **Microsoft® Exchange ActiveSync** option.
6. The *Add Account* screen displays. On this screen, enter the appropriate information in the following fields:
   - **Username**: Your username is your USC e-mail address. You must enter your full e-mail address in this field.
   - **Email Address**: Enter your USC e-mail address. You must enter your full e-mail address in this field.
   - **Password**: Enter your USC password in this field.
   - **Server Address**: Enter the server address in this field. The server address is m.outlook.com.
7. Next, swipe down the screen to display more settings. Configure the following settings:

**Port:** Enter 443 in the Port field.

**Use SSL:** This setting should be set to On.

**Use VPN:** This setting should be set to Off.

**Push:** This setting should be set to On.

![Add Account settings](image)

The **Sync Interval** and **Sync Timeframe** settings are based on personal preference. Select the settings that best fit your needs.

8. Tap **Next**. The settings you entered are verified by the device.
9. The Add Account screen reloads and displays additional account configuration options.

It is recommended that all settings on this screen be set to On. However, the only setting that is required to be set to On is Sync Email.

10. Tap Done to complete the e-mail setup process.

This completes the setup process for BlackBerry 10 devices. Your USC e-mail account is now available for use on your device.
Configuring Your E-mail For Use On An iPhone/iPod Touch/iPad Device
Follow the steps below to configure the e-mail client on your Apple® mobile device for use with your USC e-mail account.

1. From the device's desktop, locate and tap the Settings icon.

The Settings screen appears.
2. Tap **Mail, Contacts, Calendars**.

The **Mail, Contacts, Calendars** screen displays.
3. Tap **Add Account...**

The **Add Account...** screen displays.
4. Tap Microsoft Exchange.

The Exchange screen displays.

5. In the Email field, enter your USC e-mail address. You must enter the full e-mail address.

<table>
<thead>
<tr>
<th>NOTE:</th>
<th>You must use your full USC e-mail address to login.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Example:</td>
<td><a href="mailto:johndoe@usc.edu">johndoe@usc.edu</a></td>
</tr>
</tbody>
</table>

6. In the Password field, enter your USC password.

7. In the Description field, enter an account description, such as USC. Entering a description in this field is optional.
8. After populating the *Email*, *Password*, and *Description* (optional) fields, tap **Next**.
9. The information entered in the *Email*, *Password*, and *Description* (optional) fields is verified by the Exchange server.
10. After the information has been verified, check marks appear at the end of the Email, Password, and Description (optional) fields indicating that the information entered is correct.
11. After a 3-5 second delay, the screen reloads and displays the available options for the account. From this screen, you have the ability to enable or disable the features that will sync with your USC account. The available options are **Mail**, **Contacts**, **Calendars**, and **Reminders**. By default, all options are set to **ON**. Tap the item(s) that you want to disable.

| **NOTE:** | The Mail option must be set to **ON** in order to access and sync your USC e-mail account. |
12. After selecting the options you want to enable for this account, tap Save. The Adding Account screen displays.
13. When the account has been successfully added to your iPhone/iPod Touch/iPad, the screen title changes to *Account Added*. 
14. After a 3-5 second delay, the *Mail, Contacts, and Calendars* screen displays. The Exchange account that you just created now appears in the listing of e-mail accounts, as shown below.

![iPhone/iPod Touch/iPad settings screen](image)

This completes the setup process for iPhone/iPod Touch/iPad devices. Your USC e-mail account is now available for use on your device.
Configuring Your E-mail For Use on a Windows Mobile Device

Follow the steps below to configure the e-mail client on your Windows mobile device for use with your USC e-mail account.

1. From the device desktop, tap the **Envelope** icon.

![Envelop icon on Windows mobile device]

The **ADD AN ACCOUNT** screen displays.
2. The **ADD AN ACCOUNT** screen displays several mail configuration options. Tap **Outlook** to configure your USC e-mail account.

The **OUTLOOK** screen displays.
3. In the appropriate fields on the OUTLOOK screen, enter your USC e-mail address and password.

NOTE: You must use your full USC e-mail address to login.
Example: johndoe@usc.edu
4. Tap **sign in**, located at the bottom of the *OUTLOOK* screen. The e-mail account settings are verified. When the verification process is complete, the *ACCOUNT ADDED* screen displays.

If you want to download Microsoft Lync®, leave the checkbox selected. If you do not want to download Lync, de-select the checkbox. Downloading Lync is optional.

5. Tap **done**.

This completes the setup process for Windows devices. Your USC e-mail account is now available for use on your device.
Re-sending an E-mail Message

Occasionally, the need to re-send an e-mail message may arise. Re-sending an e-mail is a time saver, as you do not have to re-type the information in the e-mail, or even copy and paste the contents. Microsoft® Outlook® contains a built-in feature that provides the ability to re-send a message that has previously been sent.

1. To re-send a message, select the **Sent Items** folder and locate the e-mail that you want to re-send.

2. Open the e-mail you want to re-send. Then, select **Actions** from the **Move** menu in the tool bar. A drop-down menu displays.

3. From the drop-down menu, select **Resend This Message**. A new e-mail message, containing all the text and message history of the original message, is created and addressed to the original recipient. You can now send this message just as it is, add additional recipients, or edit it the message content.

Repeat these steps for each e-mail you want to re-send.
Displaying Discussion Threads as Conversations

In an effort to link stored messages that are related, Microsoft® Outlook® can display the e-mails as conversations. You can enable this setting for all folders in your mailbox or for a single folder.

1. From the Outlook main tool bar, select the View tab. Next, select the folder to which you want to apply the setting from the folder list on the left side of the screen. For this example, the folder Training Sessions is selected. Select the Show as Conversations checkbox.
2. After selecting the Show as Conversations checkbox, a window displays that provides the ability to apply this feature to all folders or only a specific folder in your mailbox. For this example, This Folder is selected.

![Image showing Show as Conversations dialog box]

3. After making the appropriate selection, the Reading Pane (the area that displays your e-mail messages) displays the messages in a collapsed view. Expand the conversation to view all the messages nested within the conversation.

![Image showing collapsed conversation]

Repeat these steps for other folders, as is appropriate.
CHAPTER 2: USING MICROSOFT OUTLOOK

Configuring Your Junk E-mail (SPAM) Settings

Microsoft® Outlook® utilizes IronPort®, the junk mail/SPAM filter that is provided by the University of Southern California (USC). Outlook contains its own SPAM filtering capabilities. However, IronPort and Outlook's SPAM filtering capabilities running simultaneously can result in e-mails that are not SPAM being incorrectly identified as SPAM. To avoid this issue, the SPAM filtering capabilities in Outlook must be disabled.

1. To begin, open Outlook and click Junk, located on the tool bar. A drop-down menu displays.
2. Select **Junk E-mail Options**... The *Junk E-mail Options* screen displays.

3. Select the **No Automatic Filter** radio button. Then, click the **OK** button to apply the setting change.
Additionally, the same change must be made in the web-based version of Outlook.

1. Navigate to http://dornsife.usc.edu/365 and login to the Outlook Web Application (OWA) with your USC e-mail address and password.

<table>
<thead>
<tr>
<th>NOTE:</th>
<th>You must use your full USC e-mail address to login.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Example:</td>
<td><a href="mailto:johndoe@usc.edu">johndoe@usc.edu</a></td>
</tr>
</tbody>
</table>

2. After logging into OWA, select **Options**, located on the right side of the screen. A drop-down menu displays.

3. Select **See All Options**... The *My Account* page displays.
4. Select **Block or Allow**. The *Block or Allow* page displays.

5. Select the **Don't move e-mail to my Junk E-Mail folder** radio button. Then, select **Save**, located on the bottom, right side of the page.

The desktop and Internet-based Outlook junk mail/SPAM options are now properly configured.
Creating Recurring Appointments

Some meetings are a one-time occurrence. Other meetings, such as staff or departmental meetings may recur at specific intervals throughout the year. Microsoft® Outlook® provides the ability to create recurring appointments in the Calendar.

Complete the following steps to create a recurring appointment.

1. Launch Outlook and open the Calendar. Select the **New Appointment** icon.

2. Enter the meeting information, such as the location, date, time, and the subject of the meeting. If you are inviting other people to your meeting, select the **Invite Attendees** icon and add the appropriate individual(s) to your meeting.

3. After entering the appropriate information for the meeting, select the **Recurrence** icon, located at the top of the screen.

The **Appointment Recurrence** window displays.

©2013 University of Southern California. All rights reserved.
4. The Appointment Recurrence window provides the ability to define the meeting’s recurrence pattern. The recurrence must have a pattern. There is no ability to create a recurring meeting that does not repeat in a patterned manner.

![Appointment Recurrence Window]

Configure the appropriate recurrence options for your meeting. When you have finished, select the OK button.

5. After completing adding information to your meeting, select the Save & Close icon at the top of the window.

![Save & Close Icon]

The recurring appointment now appears on your calendar.

Repeat these steps for each additional recurring meeting you want to create.
Creating Rules and Signatures

Novell® GroupWise® and Microsoft® Outlook® both support the use of rules and e-mail signatures. However, when your e-mail account is migrated from GroupWise to Outlook, the rules and signatures do not transfer. Therefore, you will need to recreate any rules or e-mail signatures you have defined.

Creating a Rule

Complete the following steps to create a rule.

1. Launch Outlook and select the File tab. Next, select the Manage Rules & Alerts button.

   ![Image showing the Rules and Alerts window]

   The Rules and Alerts window displays.
2. On the Rules and Alerts window, select **New Rule**...

The **Rules Wizard** window displays.
CHAPTER 2: USING MICROSOFT OUTLOOK

3. Select the **New Rule**... icon. The *Rules Wizard* window displays.

![Rules Wizard Window]

4. Use the *Rules Wizard* window to create and configure any rules you want to apply to your mailbox.

5. After creating the necessary rules, select the **Finish** button, located at the bottom of the screen.

Repeat these steps to create additional rules.
Creating an E-mail Signature
Creating an e-mail signature provides a quick way to include your contact information in e-mails that you send. Complete the following steps to create an e-mail signature.

1. Launch Outlook and select the File tab. Then, select Options on the left side of the screen.

The Outlook Options window displays.
2. Select **Mail** on the left side of the *Outlook Options* window. Then, select the **Signatures**... button.

The *Signatures and Stationary* window displays.
3. Use the *Signatures and Stationary* window to create an e-mail signature and set the automatic application rules (optional).

You can create multiple e-mail signatures within Outlook. Repeat these steps as necessary.
Creating and Accessing Your Personal Archive

Creating a personal archive of your e-mail messages is a great way to keep a record of communications that you may need to reference in the future. You can designate the frequency at which messages are archived, and access them as needed.

NOTE: The personal archive feature is not available in Microsoft® Outlook® 2011 for Mac®.

Creating an Archive

1. Launch Microsoft Outlook and right-click on the Inbox folder, located on the left side of the window.

A pop-up menu displays.
2. From the pop-up menu, select **Properties**... The *Inbox Properties* window displays.

Select the **Policy** tab.
3. Select the **Policy** tab. At the bottom of the **Policy** tab is the *Online Archive* section.

![Inbox Properties](image)

4. Select the **Move Items to the Archive when older than:** drop-down menu to select the frequency with which items are to be archived. After selecting a frequency, select the **OK** button to save your selection.

**NOTE:**
The Parent Folder Policy is an option that can be selected in the **Move Items to the Archive when older than:** drop-down menu. The Parent Folder Policy in this scenario is to never archive items.

Creating a personal archive is now complete.
Accessing Your Personal Archive

After creating your personal archive, you will want to access the information in the archive.

1. Launch Outlook. Select the **Home** tab if it is not already selected.

2. Located in the menu on the left side of the screen is an option that appears similarly to the following: **Archive - yourUSCID@dornsife.usc.edu**. Expand this option to view and access your personal archive.

The process of creating and accessing a personal archive is complete.
Posting a Message in a Folder

In Novell® GroupWise®, you may have used the Posted Message feature. The Posted Message feature provides the ability to post a note, generally to oneself, in any folder in your mailbox. The same functionality is present in Microsoft® Outlook® and is labeled Post in This Folder. In order to post a message in any folder of your choosing, you will need to add the option to your Outlook tool bar.

To add the Post in this Folder icon to your tool bar, complete the following steps.

1. Open Outlook and verify that the Home tab is selected. Then, right-click with your mouse anywhere in the tool bar. A pop-up menu displays.

2. Select Customize the Ribbon... The term ribbon and tool bar are synonyms and may be used interchangeably throughout this topic. The Outlook Options window displays.
3. In the center of the Outlook Options window are two columns. In the Choose commands from: drop-down menu above the left column, select All Commands.
4. New options are now displayed in the left column. Scroll through the options and highlight **Post in This Folder**. Next, select the **New Group** button, located under the right column.
5. Select the Add >> button, located in between the two columns. Post in This Folder is displayed in the New Group you created.

6. Select the OK button at the bottom of the window. A Post in This Folder icon is now displayed in the Outlook tool bar.

You now have the ability to post a message in any folder in your mailbox, quickly and easily, using the newly added icon.
Changing the Subject Line of Received E-mail Messages

E-mail messages often contain information that you will want to reference in the future. However, the e-mail's original subject line may not contain text that will assist you in easily identifying the e-mail in your e-mail filing system. Microsoft® Outlook® provides the ability to change the subject line of an e-mail you have received.

1. Open the received e-mail for which you want to edit the subject line. Highlight the subject line of the e-mail.
2. Begin typing the new subject line of the received e-mail. When you are finished entering the new text, select the Save icon at the top of the e-mail.

The new subject line is now displayed. Repeat these steps for each e-mail subject line you want to change.
Changing an Item Type

Often, e-mail discussions will lead to a face-to-face meeting, or you will want to retain a message history with a particular contact in your address book. Microsoft® Outlook® provides the ability to change an item type from one form to another. This allows you to keep all of your relevant e-mail history, but transfer it to an appointment you need to create.

For this example, an e-mail message will be changed to an appointment. The steps are the same to change any item type from one to another.

1. Open Outlook and select an e-mail message to change to an appointment type. Hold your left mouse button down and drag the e-mail message to the Calendar icon, located on the left side of the screen. The Calendar icon is now surrounded by a rectangle.
2. Release the left mouse button. A new calendar appointment displays and contains all of the message history from the e-mail. An example is below.

Repeat these steps to change an item from one type to another.
CHAPTER 2: USING MICROSOFT OUTLOOK

Giving and Receiving Delegate Access
Delegate access is granted to individuals (delegatees) who will manage certain aspects of Microsoft® Outlook® for another person (delegator). For example, a delegatee may have permission to send e-mail messages on behalf of the delegator, or to manage the delegator's calendar. Novell® GroupWise® referred to this feature as Proxy Access. Delegate access replaces proxy access in Microsoft Outlook.

Granting Delegate Access
To grant an individual or individuals delegate access, follow the steps below.

1. Launch Outlook and select the File tab. Then, select Account Settings. A drop-down menu displays.

Select the File tab.
Select Account Settings.
Select Delegate Access.
2. Select **Delegate Access** from the drop-down menu. The *Delegates* window displays.

The *Add Users* window displays.
3. In the Search field on the Add Users screen, enter the name of the person to whom you want to grant delegate access. The center of the window will automatically scroll to the entry closest to the text you entered. Highlight the name of the person to whom you want to grant delegate access, and select the Add -> button.

The delegate's name appears in the field adjacent to the Add -> button. Select the OK button to continue.
4. The *Delegate Permissions* window displays. Set the appropriate permission level for this delegate. Then, select the **OK** button.
5. The delegate access is now granted and the delegatee you designated is now listed in the *Delegates* window.

![Delegates window](image)

6. Select the **OK** button to close the *Delegates* window.

**Receiving Delegate Access**

Receiving delegate access is very simple. All you must do, as the delegatee, to access the items to which you have been granted access, is open the item. See the Accessing an Organizational or Resource Account in Outlook help topic for information on accessing your delegated items.
Accessing an Organizational or Resource Account in Outlook

If you have permissions to view or edit an organizational account (e.g., a department e-mail address that is not associated with a particular person) or resource account (e.g., a conference or meeting room calendar for scheduling), you will want to access that account via Microsoft® Outlook®. Complete the following steps to access the organizational or resource account in Outlook.

1. Launch Microsoft Outlook and then select the **File** tab. Next, select the **Account Settings** button. A drop-down menu displays. Select **Account Settings...** from the drop-down menu.

The **Account Settings** window displays.
2. On the Account Settings window, select the Change... icon.

The Change Account window displays.
3. Select the **More Settings...** button, located on the bottom right of the *Change Account* window.

The *Microsoft Exchange* window displays.
4. Select the **Advanced** tab.
5. On the **Advanced** tab, select the **Add** button.

The **Add Mailbox** window displays.

6. Enter the name of the organizational or resource account you want to view in Outlook in the **Add mailbox** field, and then select the **OK** button.
7. The organizational or resource account now appears below the folders list, located on the left side of the Outlook window.

Repeat these steps for each organizational or resource account you want to view in Outlook.
Sending an E-mail to Shared Contacts

Microsoft® Outlook® provides the ability to share a personal address book across an organization. However, once an address book has been shared, it does not appear in the Address Book drop-down list when selecting an address book to utilize.

To utilize the shared contacts, you must complete the following steps.

1. Open the shared contacts by navigating to File > Open > Other User's Folder or select Open This Contacts folder from the top left side of the sharing invitation email you may have received.

2. Select all of the contacts in the shared address book and copy them to your own personal address book. You can highlight all the contacts and then copy and paste them into your personal address book or, you can highlight all of the contacts and then drag them to your personal address book using the left mouse button. Use the Ctrl key and the left mouse button at the same time to highlight multiple contacts at one time.
3. After copying the contacts to your own address book, highlight the contacts to which you want to send an e-mail. Use the Ctrl key and the left mouse button at the same time to highlight multiple contacts at one time.

4. From the Communicate section of the tool bar, select the E-mail icon. A new e-mail window displays. The e-mail is automatically addressed to the contacts you highlighted previously.

5. If you need to include an additional contact to this e-mail, manually enter their e-mail address or copy and paste their e-mail address from their contact information. Repeat this process as necessary.
Searching Microsoft® Outlook®

Microsoft Outlook provides a variety of search options to assist you in locating the specific item you seek.

Each folder within your mailbox contains a contextual search bar. An example of how to access the contextual search bar is below.

Select the Trash folder located in the menu on the left side of the screen. A contextual search field (i.e., a field that will search the specific folder you selected) displays.

Place your cursor inside the contextual search field. After placing your cursor in the contextual search field, a new tool bar menu, Search Tools, displays.

The Search Tools menu provides a variety of additional search options and methods. You can use the contextual search field to search the folder you selected for a specific item. You can also use one of the more advanced search options available from the Search Tools menu. For example, if the e-mail message for which you are searching has an attachment, you can select the Has Attachments option to filter your search results by e-mail messages containing attachments.

Explore all of the options available on the Search Tools menu to assist you in locating the message you seek. Selecting an e-mail or folder de-activates the contextual search field and the Search Tools menu. Place the cursor back in the contextual search field to re-display the Search Tools menu.
CONTACT DORNSIFE TECHNOLOGY SERVICES

Campus Office:  
825 Bloom Walk, ACB 530  
Los Angeles, CA 90089-1486

Technical Support:  213-740-2775

E-mail: clhd@usc.edu